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1 Introduction to RT-Eye InfiniBand Compliance Module

This document provides the procedures for making InfiniBand compliance measurements with Tektronix
TDS/CSA7000, DSA/DPO 70000 and TDS6000 series real time oscilloscopes (4 GHz models and above).
The InfiniBand Compliance Module (Opt. IBA) is an optional software plug-in to the RT-Eye Serial Data
Compliance and Analysis application (Opt. RTE). The InfiniBand Compliance module provides Amplitude,
Timing, and Jitter measurements described in the electrical specification sections of the InfiniBand
Architecture Specification.

The IBTA-CIWG (InfiniBand Trade Association - Compliance and Interoperability Working Group) has
defined a suite of electrical measurements that InfiniBand devices must pass to qualify for the InfiniBand
Integrators List (IL). Manufacturers periodically perform these measurements on their InfiniBand devices at
InfiniBand plugfests. The RT-Eye InfiniBand Compliance Module automates and provides Pass/Fail limit
testing on many of these required IL measurements, as well as additional measurements that appear in the
electrical specification.

In the subsequent sections, step-by-step procedures are described to help you perform these measurements
on your InfiniBand devices. Measurements that are required to qualify for the IL are noted as such and
appear in the IBTA CIWG Subgroup Method of Implementation (MOI) document available for
download to IBTA members at www.infinibandta.com.

2 Background on InfiniBand Compliance Testing

2.1 Compliance Statements and Test Definitions (TDs)

Compliance statements appear in the InfiniBand architecture specification.
Chapter 6 - driver characteristics compliance statement are as follows:

C6-7: All output ports SHALL comply with the parameters and notes of the Table 16 Driver
Characteristics using appropriate parameters as noted.

From compliance statements, the CIWG-PHY (Compliance and Interoperability Working Group —
Physical Layer Subgroup) has developed Test Definitions (TDs) for measurements in Table 16. Test
Definition assertions that have been given the following designations.

InfiniBand Compliance Measurements 1
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Table 1 - Chapter 6 Driver Test Definitions (TDs) from Table 16 of the Specification

CIWG-PHY | Measurement Symbol in
D Chap. 6, Table 16 Min Max
Assertion
V2c6- Common Mode Voltage Veu 0.5v 1.0v
007#01
V2c6- Pk-Pk Differential Voltage Vdiff Table19? 1.6V
007#02
V2c6- Disable Mode Output pk-pk Vdisable 0 85mv
007#03
V2c6- Disable Mode Output max Vdisable 0 1.6V
007403
V2c6- Standby Mode Output pk-pk Vstandby 0 85mv
007#04
V2c6- Standby Mode Output max Vstandby 0 1.6V
007#04
V2c6- Driver Rise/Fall Time (20-80%) torr 100ps
007#05

AC Common Mode Voltage Vacem 25mv
V2c6- Driver Total Jitter Jr Table19*
007#14
V2c6- Driver Deterministic | Jitter Jo 0.17UI
007#14

! Minimum Differential Pk-Pk Voltage and Jitter @ 10 BER is dependent on Table 19 in Chapter 6 of the InfiniBand
specification. Test Points (compliance points) are defined based on where in the system the measurement is being made.
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Figure 1 — Compliance Points from InfiniBand Specification

Chapter 7 Cable characteristics compliance statement is as follows:

C7-16: Cable assemblies to be used for InfiniBand shall meet the electrical requirements listed in Table 30
for all link widths for port type 1.

Table 2 — Chapter 7 Cable Test Definitions (TDs) from Table 30 of the Specification

CIWG-PHY TD
Assertion Measurement Symbol in Min Max

V2¢7-002#09 Cable Connector Near End Cross Talk

V2c7-002#010 Cable Assembly Min Differential Voltage VCout 316mv
V2c07-016#01 Cable Differential Impedance Zdca(nom)

V2c07-016#02

V2c07-016#05 Cable Connection Jitter Jca 25Ul

InfiniBand Compliance Measurements 3
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2.2 Integrator List Tests for InfiniBand

Table 3 shows the measurements that are available in the RT-Eye InfiniBand Compliance Module and how
they map to electrical measurements in Chapter 6 and Chapter 7 of the InfiniBand Architecture
Specification. Also shown is whether or not the measurement is an Integrator List (IL) test. IL tests are
required to have your device certified as InfiniBand compliant. Other measurements are useful, but not
required.

Table 3 — RT-Eye Measurements Mapped to Chapter 6 and Chapter 7 Measurements

Available in RT-Eye InfiniBand
Measurement Integrator List Tests Compliance Module

Electrical Driver Measurements (Chapter 6 of IBA Specification)

Waveform Eye Height Yes Yes
Waveform Eye Width No Yes
Common Mode DC Voltage No Yes
Common Mode AC Voltage No Yes
Transmitter Peak-Peak Voltage Yes Yes
Transmitter Transition Time Yes Yes
(20-80 Rise/FallTime)

Driver Total Jitter @ e-12 BER Yes Yes
Electrical Cable Measurements (Chapter 7 of IBA Specification)

Cable Connected Eye Height No Yes
Cable Connected Eye Width No Yes
Cable Connection Jitter (TIE) Yes Yes
Cable Connector Minimum Differential Yes Yes
Voltage

Cable Connector Near End CrossTalk Yes No (Use TDS8000 series sampling

oscilloscopes)

Cable Differential Impedance Yes

4 InfiniBand Compliance Measurements
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3 InfiniBand Driver Compliance Measurements (MOIs)

This section applies Methods of Implementation (MOI) to the Test Definitions as they relate to Tektronix
real-time oscilloscopes, probing solutions, and RT-Eye Serial Compliance and Analysis software.

3.1 Required Equipment

The following equipment is required to take the measurements in this document.

e TDS/CSA7404 or TDS6000 series oscilloscope equipped with TDS RT-Eye software (Opt. RTE) and
InfiniBand Compliance Module (IBA).

e Probes — probing configuration is MOI specific. Refer to each MOI for proper probe configuration.
e InfiniBand breakout cable (available from Fujikura Ltd.)

Figure 2 - Fujikura InfiniBand 4X Break-out harness

3.2 Connecting to the driver under test
The first step is to probe the link. Connect your probes based on one of the four methods described below.

Table 4 — Probing Configurations for an InfiniBand Link

Probing Configurations Captured Waveforms System Specifications
Break o | oi ” . TDS6604 TDS/CSA7404
X annels ifferentia ommon Rise* Rise*
Firelae SLei;lzl Used Mode Mode VBV?;ti Time VBVIat?t’; Time
(20-80) (20-80)
SMA A | 2xTCA-SMA Y 2 Pseudo AC 6GHz | 53ps | 4GHz | 75ps
Connection | B | 1 x P7350SMA Y 1 True No 5GHz | 65ps | 4GHz | 75ps
ECB 2 x P7260 Y/N 2 Pseudo AC/DC 6GHz | 53ps | 4GHz | 75ps
Pad C 2 x P7350 YIN 2 Pseudo AC/DC 5GHz | 65ps | 4GHz | 75ps
. 2 x P7240 Y/N 2 Pseudo AC/DC na na 4GHz | 75ps
Connection = —=572e0 YN 1 True No 5GHz | 65ps | 4GHz | 75ps

*Typical

InfiniBand Compliance Measurements 5
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SMA Connection

1. Two TCA-SMA inputs using SMA

cables (Chl) and (Ch3)

The differential signal is created by the
RT-Eye SW from the math waveform
Ch1-Ch3. The Common mode AC
measurement is also available in this
configuration from the common mode
waveform (Ch1+Ch3)/2. This probing
technique requires breaking the link
and terminating into the 50 Q/side
termination into the oscilloscope. While
in this mode, the InfiniBand SerDes
will transmit the 320 bit Jitter test
pattern designed to maximize data
dependent jitter. Ch-Ch deskew is
required using this technique because
two channels are used.

One P7350SMA differential active
probe (Chl)

The differential signal is measured
across the termination resistors inside
the P7350SMA probe. This probing
technique requires breaking the link.
While in this mode, the InfiniBand
SerDes will transmit the 320 bit Jitter
test pattern designed to maximize data
dependent jitter. Matched cables are
provided with the P7350 probe to avoid
introducing de-skew into the system.
Only one channel of the oscilloscope is
used.
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M
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Probe Configuration A
SMA Psuedo-differential

Probe Configuration B

SMA Input Differential Probe
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3.2.2 ECB pad connection

3. Two P7260 single ended active probes (Chl) R
and (Ch3) E“ ) ﬁ;@'l o s e
The differential signal is created by the RT- .

Eye SW from the math waveform Ch1-Ch3. e [

The Common mode AC measurement is also [T " Famonon
available in this configuration from the
common mode waveform (Ch1+Ch3)/2. This
probing technique can be used for either a live
link that is transmitting data, or a link Two Single Ended Active Probes
terminated into a “dummy load.” In both cases,

the single ended signals should be probed as

close as possible to the termination resistors on

both sides with the shortest ground connection

possible. Ch-Ch deskew is required using this

technique because two channels are used.

Probe Configuration C

4. One Differential probe cw  Comew o

The differential signal is measured directly
- . . . . Sirdis F | Sirdes.

across the termination resistors. This probing E'F If E
technique can be used for either a live link that 1l
is transmitting data, or a link terminated into a ”""1.-";} ‘ l
“dummy load.” In both cases, the signals C o
should be probed as close as possible to the —
termination resistors. A single channel of the Probe Configuration D
oscilloscope is used, so de-skew is not One Differential Active Probe

necessary. Two P7350 differential probes can
be used to create probing configuration shown
in configuration “C” above.

4 Configuring a Device Under Test (DUT) for Compliance
Measurements

To perform compliance measurements on an InfiniBand link, it is required that the link be configured to
generate Back to Back TS1 (BTBTSL1) test pattern. The following describes various methods of obtaining a
TS1 signal out of ones HCA/TCA.

Beacon Method. The InfiniBand beacon signal is the default signal which is broadcast on a repeating basis
when there is no form of link established. The Beacon is comprised of 100 mSec of sleep state followed by
1 mSec of TS1’s back to back. A simple edge trigger on an instrument is capable of triggering on the leading
edge of this 1 mSec interval of TS1’s. It is recommended however that one use a delayed trigger of at least
50 uSec ensure the RC ramping found on the leading edge of this TS1 beacon be excluded from any
measurements. The trigger menu setup from TDS oscilloscopes to establish this delay is shown in Figure 3.

InfiniBand Compliance Measurements 7
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Figure 3 — Beacon method

Loop-Back Method. This method loops back the transmit line from an un-used lane into the receive lane 0
(Figure 4). This results in a periodic (100 mSec) link state training machine stimulus into IbtxIn(0) which
triggers a state change into the LTSM’s "configuration" state. The LTSM will broadcast 100 mSec of TS1’s
in a back to back form. This is the simplest method for generating the BTBTS1 pattern.

Note: The LTSM’s Config.RcvrCfg state generally cycles back around immediately into the
Config.debounce state in this configuration with no non-deterministic intervals introduced. Some systems
handle the transition through the LinkDown Default Idle state differently, and this transition can lead to a
short non-deterministic delay of ~30mSec before recycling into the Config.debounce state. In these systems
use the Instruments timeout trigger capability (dial in 10mSec timeout) combined with a trigger delay to
ensure this region of non-determinstic pre Donfig.debounce idle state does not appear in the region of data
over which jitter computations would occur. Failure to do this can result in an “insufficient number of

pattern repeats” warning.

Figure 4 — Loop back method

5 Initial Oscilloscope Setup

After hooking up to the DUT with the proper probing configuration for the test, press the DEFAULT front-
panel button and then the AUTOSET button to display the serial data bit stream.

8 InfiniBand Compliance Measurements
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6 Running the RT-Eye Software

1. Go to File > Run Application > RT-Eye Serial Compliance and Analysis.

Display  Cursors  Msasire  Masks Math  Ukilles  Help
p 4011

Fle Modules Measurements Plots Results Log  Utilities Help

Probe Type Diffs =l Serial Analysis

Start Stop
Eye tidth, Unit Differertizl e jtter Autoset
Ey= Height B interval voltage Emphasis (N @ BER Claar Rasults
Rizs Bit Ra b TIE Jith
Time 1t Rete Amplitude fHEr
Fall Low
Time Amplitude

enu: Meas->Select Hint: Select Measurements and go to Meas->Configure

Figure 5 - Default menu of the RT-Eye software

Figure 5 shows the oscilloscope display. The default mode of the software is the Serial Analysis module
(Opt. RTE). This software is intended for generalized Serial Data analysis on 8B/10B encoded copper links.

2. Select the InfiniBand Compliance Module from the Modules pull down list.

File |Modulss | Messuremerts Resuts  Litiss  Help KO Ry pye™ L

InfiniBand

Device Start Stop
5 Clear Results
fise Unit
Time Interval
Fall Differential
Time oltage

ﬁenu: Meas->Select Hint: Select Measurements and go to Meas->Configure

Figure 6 — Choosing the InfiniBand Compliance Module

Note: If InfiniBand does not appear in the list, the InfiniBand Compliance Module (Opt. IBA) has not been
installed.

The rest of this document details use of the RT-Eye InfiniBand Compliance Module to perform electrical
compliance measurements.

Online Help is available under the Help Menu for the software when it’s in the Serial Analysis Module. For
information not contained in this document, refer to the RT-Eye online help or the printable format.

InfiniBand Compliance Measurements 9



Methods of Implementation

6.1 DC Common Mode Measurement MOI

This test checks DC common mode voltage from the driver using Tektronix real-time oscilloscope, probes,
and RT-Eye compliance software. This test checks the common mode voltage level of the transmitter
output signal, is defined for a single physical bit lane, and must be repeated for each bit lane of each port
on the DUT.

TD Assertion covered: V2¢6-007.

Vcewm is defined in Vol. 2, Section 6.4, table Differential Output DC Characteristics,
Maximum Vcm=1.0V and Minimum Vcm=0.50V.

Integrator List Test: No.

DUT Signaling: The test is performed on the TS1 ordered-sets captured by the oscilloscope while the
DUT is in the Polling Active state described in section 3.3

Probing Configuration: Probe Configuration C - Use two P7260 or two P7240 active probes.

Test Procedure is as follows:

Connect the probe for the positive leg of the differential to Chl and the negative leg to Ch3.
In the RT-Eye InfiniBand compliance module, select Single Ended as the Probe Type.
Select CM Voltage as the measurement.

Select the Configure Button to access the Configuration menu.

Select the Source Tab and set up that menu as follows:

0 Live as the Source Type.

0 Select Chl, Ch3 as the D+, D-.

Select the Start button.

The RT-Eye application gives measurement results along with a Pass /Fail indication of the measurement.
See Figure 7.

ﬁenu:ﬂesul(s.>Delails Hint: You can see the detailed results here

ile Edt  Vertical  HorizfAcg  Trig  Display  Cursors Measurs Masks Math  LUklties  Help

1 Acts

InfiniBand

Start Stop
| = |

Clear Results

Figure 7 - Result of the DC Common Mode Measurement

10
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6.2 AC Common Mode Measurement MOI

This test checks the AC common mode voltage from the driver using a Tektronix real-time oscilloscope
and RT-Eye software. This test checks the common mode voltage level of the transmitter output signal, is
defined for a single physical bit lane, and must be repeated for each bit lane of each port on the DUT.

TD Assertion covered: None.

Vew is defined in Vol. 2, Section 6.4, table Differential Output DC Characteristics,
Maximum VACcm =25 mV RMS.

Integrator List Test: No.

DUT Signaling: The test is performed on the TS1 ordered-sets captured by the oscilloscope while the
DUT is in the Polling Active state described in section 3.3.

Probing Configurations (from section 3.2):
e Configuration A — Use TCA-SMA connectors with blocking capacitors.
e Configuration C - Use two P7260 or two P7240 active probes.
Test Procedure as follows:
e Connect the probe for the positive leg of the differential to Chl and the negative leg to Ch3.
¢ Inthe RT-Eye InfiniBand compliance module, select Single Ended as the Probe Type.
e Select AC CM Voltage as the measurement.
e Select the Configure button to access the Configuration menus.
o Select the Source tab and set up that menu as follows:
0 Live as the Source Type.
0 Select Chl, Ch3 as the D+, D-.
Select the Start button.

The RT-Eye application gives measurement results along with a Pass /Fail indication of the measurement.
See Figure 8.

File Madues I ts Resuls Utiities Hel Re™ | X

Ui el
ﬁenu:Results.>Details Hint: You can see the detailed results here

InfiniBand |

Start Stop
| = |

Clear Results

Figure 8 - Result of AC Common Mode Measurement
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6.3 Transmitter Peak-Peak Measurement MOI

This test checks the Pk-Pk voltage from the driver using a Tektronix real-time oscilloscope and RT-Eye
software. This test checks the Pk-Pk differential voltage level of the transmitter output signal, is defined for
a single physical bit lane, and must be repeated for each bit lane of each port on the DUT. An eye diagram
is displayed to give additional information on the health of the transmitter.

e TD Assertion covered: V2¢6-007#02

o Vdiff is defined in Vol. 2, Section 6.4, table Differential Output Differential Pk-Pk Voltage
Characteristics.
Maximum Vdiff = 1.6 V Pk-Pk, Minimum Vdiff is dependent on the test point.

Table 5 — Chapter 6 Test Point Descriptions, from Table 19 of the Specification*

Unsigned
Test | Description Waveform Eye Width
point Amplitude

(IEEE181)
TP1 Transmitted signal at the board side of the backplane connector .800 250 ps
TP2 Transmitted signal at the backplane side of the backplane connector .750 240 ps
TP3 Received signal at the board side of the connector 316 150 ps
TP4 Received signal at the backplane side of the connector 335 160 ps
TP5 Transmitted signal at the board side of the cable connector .890 250 ps
TP6 Transmitted signal at the cable side of the cable connector .820 240 ps
TP7 Received signal at the board side of the cable connector 282 150 ps
TP8 Received signal at the cable side of the cable connector .300 160 ps
TP9 Transmitted signal at the board side of the pluggable interface socket .890 296 ps
TP10 | Received signal at the board side of the pluggable interface socket 282 126 ps
* Measurements will require de-embedding or other compensation technique for properties of measurement
fixtures and test equipment.

e Integrator List Test: Yes

o DUT Signaling: The test is performed on the TS1 ordered-sets captured by the oscilloscope while the
DUT is in the Polling Active state described in section 3.3.

e Probing Configurations (from section 3.2):
e Configuration A — Use TCA-SMA connectors with blocking capacitors.
o Configuration B — Use P7350SMA probe (recommended).

e Connect via port breakout (Fujikura fixture in 4X case) to SMA inputs of probe configuration.

InfiniBand Compliance Measurements
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e Test Procedure is as follows:

e Connect the SMA connectors from the Break-out Harness to Ch1 and Ch3 of the oscilloscope, or
to Ch1l depending on the probe configuration used.

e Inthe RT-Eye InfiniBand compliance module, select Single Ended as the Probe Type if using
probe configuration (A), or Differential as the Probe Type if using probe configuration (B).

o Select Eye Height and Differential Voltage as the measurements.
e Select the Configure button to access the Configuration menus.
e Select the Source tab and set up that menu as follows:

0 Live as the Source Type.

0 Select Chl, Ch3 as the D+, D- if using probe configuration (A) or select Ch1l if using probe
configuration (B).

e Select the Start button.

The RT-Eye application gives measurement results along with a Pass /Fail indication of the measurement.
See Figure 9.

} RT-Eye Plot Summary

eEae BEdE B F s

InfiniBand

Start Stop

Clear Results

lenu: Results—>Sum... |Hint: You can see the Summary of the results.

Figure 9 - Result of the Differential Amplitude Measurement

The last two lines report Pass/Fail on Min and Max of Diff Voltage Pk-Pk. The waveform is also compared
to a waveform mask where the vertical and horizontal dimensions are defined by amplitude and jitter eye
width. Note that the Lower Limit on the voltage is listed as 986 mV. The specification indicates 890 mV as
the lower limit to TP5. Care should be taken to properly account and compensate for (Instruments external
attenuation menu) for all line losses between the test-point and the instrument inputs.

The signal tested in this example exhibited 989 mV Pk-Pk amplitude. The measurement is a cycle-cycle
differential voltage measurement on a 101 or a 010 bit combination. Note that this voltage is higher than
the measured Eye Height in the eye diagram (960 mV).

InfiniBand Compliance Measurements 13
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6.4

This is typical, since the eye diagram adds a “smearing affect” that hides the true minimum differential Pk-
Pk number. If you select the Details button in the RT-Eye software, it can be seen that the Min and Max
Pk-Pk measurement were derived from 23,283 valid measurements within the real time acquisition. See
Figure 10.

InfiniBand |

Start Stop

El R

Clear Results

[Menu:Results->Details |[Hint: You can see the detailed results here
Figure 10 - Details View of Pk-Pk measurement

Rise/Fall Time Measurements

This test checks the Transition Times from the driver using Tektronix real-time oscilloscope and RT-Eye
software. This test checks the 20-80% Rise/Fall times of the transmitter output signal and compares them
against the specified limits. This test is defined for a single physical bit lane and must be repeated for each
bit lane of each port on the DUT.

e TD Assertion covered: VV2c6-007#05

o tDRFis defined in Vol. 2, Section 6.4, Table 16 of the specification, Characteristics
Minimum tDRF = 100 ps.

e Integrator List Test: Yes

e DUT Signaling: The test is performed on the TS1 ordered-sets captured by the oscilloscope while the
DUT is in the Polling Active state described in section 3.3.

e Probing Configurations (from section 3.2):

e Configuration A — Use TCA-SMA connectors with blocking capacitors.

e Configuration B — Use P7350SMA probe (recommended).

e Connect via port breakout (Fujikura fixture in 4X case) to SMA inputs of probe configuration.
e Test Procedure is as follows:

e Connect the SMA connectors from the Break-out Harness to Ch1 and Ch3 of the oscilloscope, or
to Ch1l depending on the probe configuration used.

¢ Inthe RT-Eye InfiniBand compliance module, select Single Ended as the Probe Type if using
probe configuration (A) or Differential as the Probe Type if using probe configuration (B).

o Select Eye Height and Differential Voltage as the measurements.
e Select the Configure button to access the Configuration menus.
o Select the Source tab and set up that menu as follows:

0 Live as the Source Type.

0 Select Chl, Ch3 as the D+, D- option if using probe configuration (A), or select Ch1l if using
probe configuration (B).

InfiniBand Compliance Measurements
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o Select the Meas Params tab and set up that menu as follows:
0 TP6 (Transmitted signal at the cable side of the cable connector) as the Test Point.
o Stand By or Disable as the Differential Voltage Mode.
e Select the Start button.

The RT-Eye application gives measurement results along with a Pass /Fail indication of the measurement.
See Figure 11.

File Modules Measurements Results  Ubiities  Help O RT.Eve ™ | X

InfiniBand |

Start Stop
| = |

Clear Results

lenu: Results-->Sum...  Hint: You can see the Summary of the results.

Figure 11 - Results of Transition Time Test

6.5 Driver Jitter Measurements

This test checks the Total Jitter from the driver using Tektronix real-time oscilloscope and RT-Eye
software. This test checks the values of Total Jitter @ 10™? BER and Deterministic Jitter and compares
them against the specified limits. This test is defined for a single physical bit lane and must be repeated for
each bit lane of each port on the DUT.

e TD Assertion covered: VV2¢6-007#14

o Total Jitter (J1) and Deterministic Jitter (JD) for the driver are defined in Vol. 2, Section 6.4, Table
16 Driver Characteristics. Jitter Eye Opening at different compliance points are defined in Table 5.

e Integrator List Test: Yes

e DUT Signaling: The test is performed on the TS1 ordered-sets captured by the oscilloscope while the
DUT is in the Polling Active state described in section 3.3.

e Probing Configurations (from section 3.2):

e Configuration A — Use TCA-SMA connectors with blocking capacitors.

e Configuration B — Use P7350SMA probe (recommended).
e Connect via port breakout (Fujikura fixture in 4X case) to SMA inputs of probe configuration.
e Test Procedure is as follows:

e Connect the SMA connectors from the Break-out Harness to Ch1 and Ch3 of the oscilloscope, or
to Ch1l depending on the probe configuration used.

¢ Inthe RT-Eye InfiniBand compliance module, select Single Ended as the Probe Type if using
probe configuration (A) or Differential as the Probe Type if using probe configuration (B).

e Select Jitter @ BER as the measurement.

e Select the Configure button to access the Configuration menus.

InfiniBand Compliance Measurements 15



Methods of Implementation

16

e Select the Source tab and set up that menu as follows:

0 Live as the Source Type.

0 Select Chl, Ch3 as the D+, D- option if using probe configuration (A), or select Ch1 if using

probe configuration (B).

e Select the Meas Params tab and set up that menu as follows:
0 TP6 (Transmitted signal at the cable side of the cable connector) as the Test Point.

o Stand By or Disable as the Differential Voltage Mode.

e Select the Start button.

The RT-Eye application gives measurement results along with a Pass /Fail indication of the measurement.

See Figure 12.

J RT-Eye Plot Summary

== R R s

File Modules Measirements Plobs Results Log Ltiliies  Help
Serial Analysis
Start Stop

Clear Results

lenu:Results->Details  |Hint: You can see the detailed results here

Figure 12 - Results of the Jitter Eye Opening @ 1012 BER Measurement

The results of the Total Jitter can be directly compared to Table 5, where:

Total Jitter + Jitter Eye Opening = 400ps (1UI)

Deterministic Jitter can be viewed by selecting it in the Measurement Details menu as shown in Figure 13.

Log Ukilties  Help YOU pT Eye™ | x|
Serial Analysis

File Modules Measurements Plobs  Results

Result Details: Select Measurement Jitter: Deterministic (DJ] ™
Start Stop

Clear Results

[Menu:Results=Details_|Hint: You can see the detailed resultshere
Figure 13 — Deterministic jitter results
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6.6 Combining Driver Measurements

Using the RT-Eye InfiniBand Compliance Module (Opt. IBA). all measurements can be made in a single
acquisition. Measurements that can be combined into a single acquisition are as follows:

e Eye Height/Eye Width

e Rise Time/Fall Time

e Unit Interval

e Jitter @ BER (RJ, DJ, TJ, and Jitter Eye Opening)
o Differential Voltage

7 InfiniBand Cable Measurements

7.1 Required Equipment

The following equipment is required to make the measurements in this document.

e TDS/CSA7404 or TDS6000 series oscilloscope equipped with TDS RT-Eye software (Opt. RTE)
and InfiniBand Compliance Module (IBA).

o DTG5000 series or AWGT710 signal generator
e Probes — Probing configuration is MOI specific. Refer to each MOI for proper probe configuration.
¢ InfiniBand cable test fixture (available from Gore; see Figure 14)

Figure 14 — Gore cable test fixture
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Connecting to the Driver Under Test

The connection method to the Device Under test is shown in Figure 15.

TDS/CSA Real Time

Low Jitter
(<30pSec Pk)
Signal Source

TT 2.5Gb/Sec Aggressor Signal 2
I 1an- = CH1

L— | IB Connector }

= o
SMA Cables * 3
=
4 LT el
. . iase-matchel h{
To termination 1B Ceble ke

(under test)

Figure 15 — Test Setup for IB cable testing

This test setup shows the use of a P7350SMA Differential Active probe with SMA inputs. Alternatively,
each leg of the differential signal being tested can be connected to Ch1 and Ch3 of the oscilloscope and the
measurement can be made in a pseudo-differential manner.

Configuring the Device Under Test (DUT) for Compliance Measurements

The signal generator is setup to transmit a repeating CJITPAT (Compliance Jitter Test Pattern).

Initial Oscilloscope Setup

After connecting to the DUT with the proper probing configuration for the test, press the DEFAULT front-
panel button and then the AUTOSET button to display the serial data bit stream.

Running the RT-Eye Software

Go to File > Run Application > RT-Eye Serial Compliance and Analysis. The result should be similar to
Figure 3.
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7.6 Cable Connected Minimum Differential Voltage

This test checks cable assembly minimum differential voltage using Tektronix real-time oscilloscope and
signal source. This test checks the minimum differential output voltage peak to peak of the Cable
connector output signal. This test is defined for a single physical bit lane and must be repeated for each bit
lane on the DUT (differential pair of cable).

e TD Assertion covered: VV2¢7-002#010

o Total Jitter (J1) and Deterministic Jitter (JD) for the driver are defined in Vol. 2, Section 6.4, Table
16 Driver Characteristics. Jitter Eye Opening at different compliance points are defined in Table 19
of the specification.

Notes:

e The test applies to the cable connector and to the cable assembly (ambiguously defined in the
InfiniBand Architecture Specification 1.1)

e Required instruments:

e Oscilloscope: TDS6604, TDS7404 or CSA7404 with SM option

o Signal source: Arbitrary Waveform Generator AWG610, AWG710, or DTG5000 Series.
o Differential Amplitude = 1 Vpp

e VCout (peak-peak), minimum differential output VVoltage (peak-peak) limits defined in VVol.2,
Section 7.9.2, table Cable assembly electrical performance requirements.

e Vmeas is the minimum differential voltage measured at the center of the eye Diagram (Eye
Height).

e Test must be performed on each lane on the DUT.
e Integrator List Test: Yes

o DUT Signaling: The test is performed on the CJITPAT Ordered Sets captured by the oscilloscope.
The voltage measurement is taken for 1 Vpp Fibre Channel CJTPAT stimulus for 1000 waveforms or
equivalent.

e Probing Configurations (from section 3.2):

o Configuration A — Use TCA-SMA connectors with blocking capacitors.

e Configuration B — Use P7350SMA probe (recommended).
e Connect via port breakout (Fujikura fixture in 4X case) to SMA inputs of probe configuration.
e Test Procedure:

e Connect SMA connectors from Break-out Harness to Chl and Ch3 of the oscilloscope, or to Chl
depending on the probe configuration used.

e Inthe RT-Eye InfiniBand compliance module, select Single Ended as the Probe Type if using
probe configuration (A) or Differential as the Probe Type if using probe configuration (B).

o Select Eye Width/Eye Height as the measurement.

e Select the Configure button to access the Configuration menus.
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o Select the Source tab and set up that menu as follows:

0 Live as the Source Type.

0 Select Chl, Ch3 as the D+, D- if using probe configuration (A) or select Ch1l if using probe
configuration (B).

e Select the Start button.

The RT-Eye application gives measurement results along with a Pass /Fail indication of the measurement.
See Figure 16.

Mot Available

Figure 16 - Results of the Cable Connected Minimum Differential test

7.7 Combining Cable Measurements

Using the RT-Eye InfiniBand Compliance Module (Opt. IBA). All measurements can be made in a single
acquisition. Measurements that can be combined into a single acquisition are as follows:

8 Giving a Device an ID

The InfiniBand Compliance Module provides a graphical user interface for entering a Device 1D and
Description. Data entered here will appear on the compliance report and is recommended for device

tracking.

9 Creating a Compliance Report

To create a compliance report, select Utilities > Reports. The Report Generator utility can create a complete
report of the compliance test.
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10Appendix A — Measurement Algorithms

This section is under development.
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